

    
      
          
            
  
Welcome to Read the Docs

This is an autogenerated index file.

Please create an index.rst or README.rst file with your own content
under the root (or /docs) directory in your repository.

If you want to use another markup, choose a different builder in your settings.
Check out our Getting Started Guide [https://docs.readthedocs.io/en/latest/getting_started.html] to become more
familiar with Read the Docs.
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Amulet Map Editor
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A new Minecraft world editor and converter that supports all versions since Java 1.12 and Bedrock 1.7.
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Running compiled builds

Download the zip file for your operating system from the list of compiled builds [https://github.com/Amulet-Team/Amulet-Map-Editor/releases]. (Currently Windows only)

Extract the contained folder to a location on your computer and run the executable.



Running from Source

If you are running a compiled build you do NOT need to do this.


	Install Python 3.7+ [https://www.python.org/]


	We recommend setting up a python virtual environment [https://docs.python.org/3/tutorial/venv.html] so you don’t run into issues with dependency conflicts.


	run python -m pip install amulet-map-editor to install the library and all its dependencies.


	run python -m amulet_map_editor to run the program





Notes

If you have python 2 installed python may point to the wrong version in which case you will have to swap out python for python3

When installing from source the following dependencies will be installed


	numpy


	wxpython


	pyopengl


	Amulet-Core [https://github.com/Amulet-Team/Amulet-Core]  The library to handle loading and saving data to the world formats.


	Amulet-NBT [https://github.com/Amulet-Team/Amulet-NBT]  The library to handle reading and saving NBT and SNBT.


	PyMCTranslate [https://github.com/gentlegiantJGC/PyMCTranslate]  The library to handle block, block entity, entity and biome translation. between versions


	Minecraft-Model-Reader [https://github.com/gentlegiantJGC/Minecraft-Model-Reader]  The library to handle loading block models and textures from a resource pack for use in the renderer.







Contributing

For information about contributing to this project, please read the contribution file.





          

      

      

    

  

    
      
          
            
  
Contributing

If you wish to report a bug in the program or suggest a feature please first search the existing bugs and features [https://github.com/Amulet-Team/Amulet-Map-Editor/issues] to see if it already exists.
If not create a new issue [https://github.com/Amulet-Team/Amulet-Map-Editor/issues/new/choose].

If you wish to contribute translations to the project see the translation guidelines

If you wish to contribute code to the project see the developer guidelines




          

      

      

    

  

    
      
          
            
  

name: Bug report
about: Create a report to help us improve
title: ‘’
labels: ‘’
assignees: ‘’



Has this bug already been reported? Please check if there is a bug report already open that matches this.

Describe the bug
A clear and concise description of what the bug is.

To Reproduce
Steps to reproduce the behavior:


	Go to ‘…’


	Click on ‘….’


	Scroll down to ‘….’


	See error




Expected behavior
A clear and concise description of what you expected to happen.

Screenshots
If applicable, add screenshots to help explain your problem.

Desktop (please complete the following information):


	OS: [e.g. Windows, OSX, linux]


	Version [e.g. 0.6.11]




Additional context
Add any other context about the problem here.



          

      

      

    

  

    
      
          
            
  

name: Feature request
about: Suggest an idea for this project
title: ‘’
labels: ‘’
assignees: ‘’



Has your feature request already been suggested? Please check if your suggested feature has already been suggested.

Is your feature request related to a problem? Please describe.
A clear and concise description of what the problem is. Ex. I’m always frustrated when […]

Describe the solution you’d like
A clear and concise description of what you want to happen.

Describe alternatives you’ve considered
A clear and concise description of any alternative solutions or features you’ve considered.

Additional context
Add any other context or screenshots about the feature request here.



          

      

      

    

  

    
      
          
            
  Please provide enough information so that others can review your pull request:

Explain the details for making this change. What existing problem does the pull request solve?

Make sure that the pull request targets the dev branch

We are in the process of deciding on a licence for this project.
In order for your pull request to be accepted you will need to acknowledge in the pull request that you are okay with your code being released under an as yet decided licence.
The code will remain public to view but limitations may be added to its usage and the Amulet program will remain free to use for non-commercial reasons.



          

      

      

    

  

    
      
          
            
  IMPORTANT: Please do not create a Pull Request for a new feature without creating an issue first.

Any change needs to be discussed before proceeding. Failure to do so may result in the rejection of the pull request.

Please provide enough information so that others can review your pull request:

Explain the details for making this change. What existing problem does the pull request solve?

Make sure that the pull request targets the dev branch

We are in the process of deciding on a licence for this project.
In order for your pull request to be accepted you will need to acknowledge in the pull request that you are okay with your code being released under an as yet decided licence.
The code will remain public to view but limitations may be added to its usage and the Amulet program will remain free to use for non-commercial reasons.



          

      

      

    

  

    
      
          
            
  
Amulet Documentation

When you open Amulet you should be greeted by a screen that looks similar to the image below.

[image: ../_images/main_menu.jpg]main menu

First of all backup any worlds that you intend to edit just in case they get corrupted when editing.

Click on the open world button and a new window should appear that looks like the image below.


Open World

[image: ../_images/world_select.jpg]world select

On the left should be some expandable panes containing the worlds stored in the respective directories. Click on the button to show the worlds in that location.

[image: ../_images/world_select_expand.jpg]world select expand

Click on a world to open it with Amulet.

If you wish to open a world from a different location press the “open other world” button and select the world folder.

On the right will be worlds that you have recently opened in Amulet (this will be blank if you have not opened any worlds yet).

There are some cases where you will not see a world listed or are not able to open a listed world. If it is a Java world it may be because the world was opened with Forge. We do not currently support opening these worlds but we would like to support them in the future. If this is not the case I would suggest reaching out to us either through discord [https://discord.gg/BTm6jnf] or twitter and we will try and help you.

Once you have opened a world you should see a screen that looks like the image below.

[image: ../_images/about.jpg]world select expand

On the top are the worlds that you currently have open in Amulet to make it easy to switch between. More worlds can be opened at the same time either by selecting the main menu and opening again or through File -> Open World




Sub-Programs

On the left are the different sub-programs contained within Amulet. The documentation for which can be found below.

Convert Program Documentation

Edit Program Documentation




          

      

      

    

  

    
      
          
            
  All files in this directory are from tabler-icons and fall under the MIT Licence.
This licence does not apply to any other files in this repository.
https://github.com/tabler/tabler-icons
https://tablericons.com/

MIT License

Copyright (c) 2020 Paweł Kuna

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the “Software”), to deal
in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.



          

      

      

    

  

    
      
          
            
  
Convert Program


About

The conversion program takes the world you currently have opened (the source world), in whatever format the world is in, and converts that data to the format of the destination world that you select. It then merges that data with the destination world that you select.

This means that any chunks that exist in the source world will be overwritten in the destination world. It is advised to backup both worlds before starting the conversion process in case something goes wrong. In theory only the destination world should be modified.

If there is a chunk in the destination world and there is no chunk in the source world at that location then the chunk will be left as it was.

[image: ../../../_images/convert.jpg]edit



How to use


	Make sure that any world you wish to open is not open in game or another program.


	Backup both the world you want to convert from and the world you want to convert to in case there are any corruptions.


	Open your source world. This should bring up a screen which looks similar to the image above with “convert” on the left.


	Click on the convert tab on the left if it is not enabled. This should make the screen look the same as the image above with the world imformation populated with your source world information.


	Click the select output world button and select the destination world in a similar way to how you selected the source world.


	Check that the worlds shown are the world you want to convert from and the world that you want to convert into.


	Press the convert button and wait for the loading bar to fill up. This may take a while if your source world is large.


	Once finished click the “Close World” button at the top to close the worlds before opening them in game.








          

      

      

    

  

    
      
          
            
  
Edit Program


About

The edit program is a 3D world editor with similarities to MCEdit Unified. The user can select an area and run various operations on that area.

[image: ../../../_images/edit1.jpg]edit



Controls

The controls are currently hard coded but in the future they will be customisable. They are as follows:


	forward: W


	backward: S


	left: A


	right D


	down: Shift


	up: Spacebar


	toggle camera rotation: middle click or double right click


	select box corner: Left click


	change mouse select mode: Right click (options are closest non-air block and fixed distance)


	change fly speed: Middle mouse scroll






Tools

On the left should be a bar of buttons which control different things in the editor.

Dimension: Select which dimension is active
Undo: Undo the last change. (ctrl+z)
Redo: Reapply an undone change. (ctrl+y)
Save: Save all changes to the world. Any changes in the editor are saved in the editor until the user requests them to be saved to the world. (ctrl+s)
Close: Close the current world.


Operations

The section below this is the operation section.

There is a drop down list of operations that come with Amulet and user created operations.

Below that is a button to change the options for the selected operation. This may be grayed out of the plugin does not require options.

Below that is a button that will run the operation. Some operations may require a selection of the world to run on and the user will be notified if this is the case but not all operations do.



Fill and Replace


	Select an area of the world you would like the operation to run on.


	Select the operation from the list of operations.


	Fill: Select the block you wish to fill the area with.


	Replace: Select the block you would like to replace (use * to match any value of that property) and select the block you would like to fill it with.
-Run the operation.
-Undo will undo the changes and save will apply them to the world files.






Delete Chunks


	Like with fill and replace select an area and select the operation. This operation will delete all chunks the selection overlaps with even if only partially selected.


	Run the operation and the chunks will be deleted.


	Undo will undo the changes and save will apply them to the world files.






Clone


	Select an area, select the operation and click run operation.


	The operation screen will change to allow you to pick a destination location.


	Type in the coordinate where you want it to be placed or use middle mouse wheel while hovering on a number.


	Click “Confirm” to paste the selection at the new location or “Cancel” to cancel






Copy and Paste


	Select an area and press ctrl+c to copy (or Edit -> Copy)


	Press ctrl+v (or Edit -> Paste) to choose where to paste the selection in the world. See clone for more information


	It is worth noting here that Amulet is able to have multiple worlds open at the same time and the copied area can be pasted into a different world.


	Our translation system also handles conversion between different world formats so the source and destination worlds do not need to be from the same version or platform.









          

      

      

    

  

    
      
          
            
  
Developer Contributing

This is intended for developers wishing to contribute code to the project.


Branch Naming

A branch must be created in order to contribute code to the project.
Unless you have permissions to create branches in Amulet-Team you will first need to fork the repository [https://docs.github.com/en/github/getting-started-with-github/fork-a-repo].
You must then create a branch with an identifiable name using the following convention:


	For features, use: impl-<feature name>


	For bug fixes, use: bug-<bug tracker ID>


	For improvements/rewrites, use: improv-<feature name>


	For prototyping, use: proto-<feature name>






Tests

There are a number of tests to make sure that the code behaves correctly.
If you are making changes to the code these should be run before creating the pull request.



Code Formatting

For code formatting, we use the formatting utility black [https://github.com/ambv/black].
To run it on a file, run the following command from your favorite terminal after installing: black <path to file>

While formatting is not strictly required for each commit, we ask that after you’ve finished your
code changes for your Pull Request to run it on every changed file.

The following command will run it on all files. black .



Pull Requests

Once you have added the desired changes and run tests and formatting you will need to create a pull request [https://docs.github.com/en/github/collaborating-with-issues-and-pull-requests/creating-a-pull-request].
We ask that submitted Pull Requests give moderately detailed notes about the changes and explain
any changes that were made to the program outside of those directly related to the feature/bug-fix.

Once a Pull Request is submitted, we will mark the request for review.
Once that is done, we will review the changes and may provide feedback on things to change.
Once all additional changes have been made, we will merge the request.

The tests and code formatting will be run automatically when the pull request is created to verify that everything is okay.
This can be seen at the bottom of the pull request page.





          

      

      

    

  

    
      
          
            
  
Language Contributing

This is intended for anyone wishing to contribute translations to the project.


Language Files

In order to support translations of text in the user interface all of the text has been moved into .lang files located in amulet_map_editor/lang.
The name of these lang files are RFC 1766 format language codes.
For example en for English, en_US for US English and en_GB for British English.
The lang files are formatted with one localised string per line with a = symbol separating the identifying key and the localised text.
The keys must only contain the characters a-z0-9_. and values can contain any character including the = symbol.

When loading the lang files, first the en.lang file is loaded to ensure that there is at least something for any given key.
If the language code contains an _ symbol (for example fr_CA) then the lang file for the language section will be loaded next (fr.lang).
This allows languages that do not vary much between regions to share the same language file to minimise duplication.
Finally, if it exists, the region specific language file will be loaded which should only contain entries that vary between regions.



Branch Naming

A branch must be created in order to contribute to the project.
Unless you have permissions to create branches in Amulet-Team you will first need to fork the repository [https://docs.github.com/en/github/getting-started-with-github/fork-a-repo].
You must then create a branch with an identifiable name using the following convention:


	When adding languages, use: impl-lang-<langauge code>


	When fixing languages, use: improv-lang-<langauge code>






Pull Requests

Once you have added the desired changes you will need to create a pull request [https://docs.github.com/en/github/collaborating-with-issues-and-pull-requests/creating-a-pull-request].
We ask that submitted Pull Requests give moderately detailed notes about the changes.

Once a Pull Request is submitted, we will mark the request for review.
Once that is done, we will review the changes and may provide feedback on things to change.
Once all additional changes have been made, we will merge the request.





          

      

      

    

  

    
      
          
            
  

          

      

      

    

  _images/edit1.jpg
*

Main Menu 1.160.51
1024, 132.00,59.58 = Dimension: |overworld Undo | 0 Redo |0 Save |0 Close

About

3D Editor Convert

Operation Import






_images/main_menu.jpg
nnnnnn

QAmuIetO

Open World

Help





_images/convert.jpg
Main Menu 116051

Input World:

|30 Editor | Convert Block Convert

Close World

116051
Bedrock 1.16051.1
commojang\minecraftWorlds\oK98XahRAAA=

Output World:

Select Output World

Convert






_images/edit.jpg
*

Main Menu 1.160.51
1024, 132.00,59.58 = Dimension: |overworld Undo | 0 Redo |0 Save |0 Close

About

3D Editor Convert

Operation Import






_static/ajax-loader.gif





_images/world_select.jpg
(3}

jorld Select

Open other world

[Java

>>

Bedrock

>>

Recently Opened Worlds

Debug 1.14
Java 1.144
minecraft\saves\Debug 1_14

dimensions
" Bedrock 1.16051.1
@ com.mojang\minecraftWorlds\BDt6XrSOAAA=

New World
Java 1152
minecraft\saves\New World (1)

My World
Bedrock 1.14.06.1
com.mojang\minecraftWorlds\y6EYXaxLAAA=

ok 1122 Amulet Output
Java 1122
minecraft\saves\1_12_2 Amulet Output






_images/world_select_expand.jpg
Open other world

Java
>>

Bedrock
<<

test
Bedrock 1.14.06.1
commojang\minecraftWorlds\-HYcXijjoDQA=

Recently Opened Worlds

Debug 1.14
Java 1.144
minecraft\saves\Debug 1_14

11430
Bedrock 1.1430.20
commojang\minecraftWorlds\OKt8XousAwA=

A irrsiors

Bedrock 1.160.51.1
com.mojang\minecraftWorlds\8DI6XrSOAAA=

181
Bedrock 1812
commojang\minecraftWorlds\GE4EAGPMAAA=

New World
Java 1152
minecraft\saves\New World (1)

dimensions
Bedrock 1.160.51.1
com.mojang\minecraftWorlds\8DI6XrSOAAA=

My World
Bedrock 1.14.06.1
com.mojang\minecraftWorlds\y6EYXaxLAAA=

1114
Bedrock 1.1142
commojang\minecraftWorlds\8QIGXnRzAAA=

1122 Amulet Output
Java 1122
minecraft\saves\1_12_2 Amulet Output

flat
Bedrock 1.160.51.1






_static/comment-bright.png





_static/comment-close.png





_images/about.jpg
@ AmuletV06.1 = o
File
Main Menu New World

Close World

Currently Opened World:

New World
Java 1152
minecraft\saves\New World (1)

(30 Editor | convert | Apout

Choose from the options on the left what you would like to do.
You can switch between these at any time.






_static/comment.png





nav.xhtml

    
      Table of Contents


      
        		
          Welcome to Read the Docs
        


      


    
  

_static/file.png





_static/down-pressed.png





_static/down.png





_static/up-pressed.png





_static/minus.png





_static/plus.png





_static/up.png





